
GSAK 101!GSAK 101!
Dit is een stap voor stap handleiding om u op weg te helpen bij het gebruik 
van GSAK.  Alle onderstreepte tekst in deze handleiding is een link naar 
een web site – klik op de onderstreepte tekst om via internet meteen naar 
die web site te gaan. Deze handleiding is erg gedetailleerd ( stap voor stap) 
en dus tamelijk lang. Geen paniek!  Als je de handleiding hebt door-

gewerkt kun je als snel helemaal zelfstandig met GSAK werken.

Let op: Deze handleiding is in het Nederlands, maar het programma zelf is Engels-talig!
Deze handleiding gaat over het beginnen met GSAK.  Het is de bedoeling dat je alles van 
begin tot eind doorwerkt (ook al hoeft dat niet in één keer!) Elk hoofdstuk bouwt voort op 
het voorgaande.  Als je dus zo maar doorstapt naar een willekeurig hoofdstuk  zonder dat  
je de voorgaande hebt doorgewerk zul je kernpunten gemist hebben en kun je makkelijk  
in de war raken.  

Niet alle mogelijkheden van GSAK worden hier besproken – als je over die 
mogelijkheden meer te weten wilt komen, kijk dan in het GSAK-helpbestand. 
Ga daarvoor in GSAK naar het “Help” menu, klik dan op “Contents”, of druk op de  F1-
toets van de computer.

GEOCACHING.COM  PREMIUM  MEMBERSHIP

Om maximaal van GSAK te kunnen profiteren zul je GPX (géén LOC) bestanden van 
Geocaching.com moeten downloaden.  GPX bestanden bevatten vrijwel alle informatie 
van de online cache pagina en stellen je in staat om al deze informatie in GSAK op te 
nemen.  LOC bestanden bevatten alleen de cache naam en de coördinaten (latitude en 
longitude).  Hoewel GSAK met LOC bestanden kan werken zul je dan niet de 
gedetailleerde informatie ter beschikking hebben die je maximaal van GSAK’s features 
laat profiteren.

Als je GPX-bestanden wilt downloaden dan moet je “Premium 
Member” worden bij Geocaching.com requires Dat kost je $10 
voor drie maanden of $30 per jaar.
Om Premium Member van Geocaching.com te worden moet je 
naar  https://www.geocaching.com/Membership/default.aspx 
gaan. Aan de rechterkant kun je dan kiezen voor “Get a 
Premium Membership.  Werk het hele (betalings-)proces door 
om Premium Member te worden zodat je GPX bestanden en 
Pocket Queries kunt downloaden.



DOWNLOAD HET GSAK- PROGRAMMA

Ga naar  http://gsak.net/  en download de meest recente versie van GSAK, momenteel 
versie 8.  Als dat wordt aangegeven op het scherm, sla het programma dan op op de 
computer. Vergeet niet waar je het opslaat !
Wil je GSAK alleen maar proberen, dan is dat gratis. Wil je het kopen, dan kost dat $30 
US.  De gratis download heeft alle mogelijkheden van GSAK en funktioneert gewoon. 
Na 21 dagen van gebruik zonder te registreren komt een irritantie melding naar voren als 
het programma opstart. De vertraging die daarmee gepaard gaat wordt langer naarmate je 
het programma vaker gebruikt. Als het programma je bevalt registreer het dan s.v.p. bij 
http://gsak.net/Register.php.  Als je de registratiesleutel invoert verdwijnt de melding 
voor altijd. Geregistreerde gebruikers van GSAK hebben recht op alle toekomstige 
updates.  Grote updates, naar nieuwe versies, moeten wel weer betaald worden, maar dat 
is gewoonlijk tegen een gereduceerd tarief.

INSTALLEREN VAN  GSAK

In Windows, ga naar Start>Uitvoeren en ga naar de map waar je het bestand hebt 
opgeslagen (GSAKxxxx.exe, waarbij xxxx het versienummer is).  Klik op het bestand, 
klik op “Openen” en dan op “OK”.

De installatie van GSAK zal opstarten.  Als de Windows beveiligingswaarschuwing 
verschijnt klik dan op “Uitvoeren”.

Het wordt aanbevolen om GSAK in de aanbevolen (de default) map te laten installeren. 
Klik gewoon op “Next”, “Accept”,  “Next” and “Install”.   GSAK zal op de computer 
worden geïnstalleerd.  

 GSAK DE EERSTE KEER OPSTARTEN

Dubbelklik op het GSAK ikoon op de  Windows desktop.  Het GSAK programma 
zal opstarten.  

Er zal worden gevraagd of je wilt dat  GPX and LOC bestanden aan GSAK gelinkt 
worden (associeren). Dat houd in dat iederen keer als je dubbelklikt op een van deze 
bestanden GSAK wordt gestart.  Als je nog andere geocaching software op je computer 
hebt en je wilt dat GSAK altijd start als je dubbelklikt op een GPX or LOC bestand, vink 
dan de “Force Association Each Time GSAK starts” markering aan.  Dit voorkomt dat 
andere programma’s software deze keuze weer ongedaan maakt.

Als je wel wilt dat een ander programma  geopend wordt in plaats van GSAK als je 
dubbelklikt, klik dan op  “Cancel”.  Noot: Je kunt deze instelling altijd weer veranderen 
naar GSAK door naar in GSAK naar het “Tools” menu te gaan en dan te kiezen voor 
“GPX File Association…”.

http://gsak.net/Register.php
http://gsak.net/


Als volgende installatiestap zal GSAK vragen of je de database wilt vullen met de 
voorbeeld database.  Ben je er klaar voor om echte gegevens in te voeren, klik dan op 
“no”.   Wil je spelen met de voorbeeld database, klik dan “yes”.  

Het GSAK “Getting Started” help-bestand zal geopend worden. Lees deze helptekst en 
klik op de links om een beetje vertrouwd te raken met het programma en het help-
bestand.
Maak je geen zorgen of je alles wel kunt onthouden. Deze handleiding leidt je stap voor 
stap door de basisfuncties.

HET GEBRUIK VAN GSAK

Cache-gegevens laden: Het eerste dat gedaan moet worden is het invoeren van wat 
cache-gegevens in de GSAK database.  Je kunt cachebestanden stuk voor stuk 
invoeren of, als je Premium Member bent , kun je Pocket Queries opzetten bij 
Geocaching.com. De informatie van maximaal 500 caches per keer worden dan 
naar je ge-emailed (we gaan daar later verder op in).  

Vanaf dit punt gaan we er van uit dat je Premium Member van Geocaching.com bent 
omdat , zoals we hierboven al stelden, dit de beste manier is om informatie van caches in 
GSAK te gebruiken.

In Windows, maak een map in “My Documents” om de cache-downloads te bewaren. 
Noem deze map “Geocaches”. 

Individuele Cache-gegevens downloaden: Om de gegevens van een enkele cache op te 
halen moet je inloggen bij Geocaching.com en ga naar de pagina van die cache op 
Geocaching.com en, onder “Click Icon to Download” bij de bovenrand van de cache-
pagina, klik op “GPS eXchange File (*.gpx)”.  Een “Bestand Downloaden” window zal 
worden geopend.  Klik op “Opslaan” en sla het bestand op in de “Geocaches” -map die je 
zojuist (zie boven) op je computer hebt gemaakt.  

Cache-gegevens in GSAK invoeren:  In GSAK, klik op het “File”-menu en klik op 
“Load GPX/LOC” (van hier af verwijzen we naar menu-opdrachten zoals deze, in de 
vorm “File>Load GPX/LOC”).  Een window zal zichtbaar worden dat je er aan herinnert 
om je methode te kiezen voor het koppelen van gevonden en geplaatste caches. 



Dit is een belangrijke instelling die je gebruikt om GSAK te vertellen wie je bent,  zodat 
het programma de caches die van jou zijn en de caches die je gevonden hebt kan 
herkennen.  Type je  geocaching naam (Nickname) in het invulvak (Verzeker je er van 
dat de spelling juist is !) En klik op “OK”.  Dit hoef je maar een keer te doen – deze 
melding zal nu niet meer verschijnen.

Het “Load…” dialoog zal nu verschijnen.  Klik op het kleine map-ikoon rechts van het 
eerste blanke invulvenster en ga naar je“Geocaches”-map.  Klik op het bestand dat je 
zojuist hebt opgehaald en klik op “Open”, klik dan “OK”.  GSAK zal de cache-gegevens 
in de database laden en een “Load Summary”-venster zal geopende worden dat 
informatie geeft over het bestand dat zojuist werd geladen.  Klik “OK”.

Je zult zien dat de cache nu zichtbaar wordt als een regel in de bovenste helft van het 
GSAK venster.  Dit noemen we de “Grid View” (overzichtsscherm) en elke regel in dit 
venster bevat informatie van één bepaalde cache.

Aan de onderrand van het Grid View is een statusregel die: “ Subset: None; 1 Shown (all 
waypoints); Centre Point: Greenwich Meridian; Counts” aan zal geven (gevolgd door 
vier verschillend gekleurde rechthoekjes).   Klik op de onderrand van de deze statusregel 
en hou de muisknop ingedrukt om de statusregel naar boven te trekken.
Als je de statusregel niet naar boven kunt verplaatsen druk dan op de “F2” toets op je 
toetsenbord (nu wordt het “Split Screen View” geaktiveerd), en trek nu de statusregel 
naar boven tot het midden van het scherm.

Je zult nu de informatie-pagina van de betreffende cache in de onderste helft van het 
GSAK window zien. Dit noemen we de “Split Screen View”.   

De basisinstelling is “Full Display”.  Dit toont alle cache-gegevens die in het GPX-
bestand staan zonder dat je hiervoor naar Geocaching.com op internet hoeft te gaan.  In 
het midden van de “Tool bar” bij de bovenkant van het GSAK venster, zie je een 
uitklapmenu dat “Split Screen Format” heet. Probeer de verschillende opties in dit 
uitklapmenu uit om te zien wat de diverse keuzes doen.
(Noot: Je moet met het internet verbonden zijn om de keuze“Online” te kunnen 
gebruiken!).   Zet het Split Screen Format voor dit moment terug naar “Full Display”.

 Je ‘Home Location’ vastleggen: En van de krachtige instrumenten 
van GSAK is de mogelijkheid om caches te bekijken of te sorteren in 
relatie tot hun afstand van een gewenste locatie.  Tenzij je woont op 
de Greenwich meridiaan in Engeland (weinigen van ons doen dat!), 
zal het nodig zijn dat je een “home location” (thuislocatie) vastlegt 
die aangeeft waar je woont.  

Als eerste moet je de coördinaten (latitude and longitude - breedte en lengtegraad) van je 
thuislocatie te weten zien te komen.  Als je die niet weet, ga dan naar buiten met je GPS-
ontvanger en maak een waypoint.  Neem de coördinaten van dat punt over van de GPS-
ontvanger en voer die gegevens in GSAK op de volgende manier in:



Ga naar  Tools>Options en klik op de “Locations” tab.   Klik onder “#Somewhere 
else….” in het tekstvenster en type ‘Home’(zonder aanhalingstekens en gebruik niet het 
woord Thuis, maar Home), een komma, en dan de coördinaten (die je zojuist van je GPS-
ontvanger hebt afgelezen) gescheiden door een komma.
Merk op dat de coördinaten in een van de formats zoals die in de voorbeelden in het 
tekstvenster worden getoond, moet worden ingevoerd.  Verzeker je er van dat er een 
komma staat tussen het woord Home, de lattitude en de longitude. Zorg ook dat de 
lattitude (breedtegraad) voor de longitude (lengtegraad) staat!
Neem de coördinaten exact over zoals je ze ziet op het scherm van de GPS-ontvanger, 
inclusief N of S en E of W (let op niet: Z en O !)   

Klik “OK” om terug te keren naar het GSAK grid view.  In het  “Locations” rolmenue 
van de GSAK toolbar, kies je “Home”.  De cache in het grid view toont nu de afstand tot 
je huis in kilometers, in de kolom met de aanduiding “Kms”.  “Maar ik gebruik geen 
kilometeraanduiding”, hoor ik je zeggen?    Ga naar  Tools>Options en dan de “General” 
tab. In de hoek rechtsboven klik op “Miles” onder “Distance Calculation”.   Klik OK. 
Bovenaan de kolom ‘Distance’ (afstand) het grid view is nu “Miles” en de afstand in 
relatie tot je huis wordt nu in mijlen getoond.

Pocket Queries : Om volledig voordeel te hebben van 
GSAK, zul je veel gegevens in de database moeten invoeren 
(bijv. Alle caches in je omgeving).   De beste manier om dit 
te doen is door Pocket Queries op te halen bij 
Geocaching.com.  Voor meer gedetailleerde informatie met 
betrekking tot Pocket Queries, en een stap voor stap 
handleiding om dat te organiseren kun je gaan naar:

http://www.markwell.us/pq.htm

Of, als je het gewoon wilt uitproberen, ga dan naar: http://www.geocaching.com/pocket/ 
en klik op “Create a New Query” (om dit te kunnen laten werken moet je als ‘Premium 
Member’ zijn ingelogd bij Geocaching.com !). 

Hoe dan ook, als je eenmaal een Pocket Query bij Geocaching.com hebt 
opgezet, zal er een bestand naar je worden gestuurd, gewoonlijk binnen een 
paar minuten.  Controleer dus je email!! 

Een Pocket Query in GSAK invoeren: De manier waarop je een Pocket Querie in 
GSAK invoert lijkt sterk op het invoeren van een enkel GPX-bestand.

Als eerste sla je het Pocket Query-bestand, dat bij het email-bericht is gevoegd, in de 
“Geocaches”-map (zoals je die boven hebt gemaakt) op de computer.

Vervolgens ga je naar File>Load in GSAK en navigeer je naar de Geocache-map.

http://www.markwell.us/pq.htm
http://www.geocaching.com/pocket/


Klik op het opgeslagen Pocket Query-bestand (noot: GSAK is slim genoeg om ge-zipte 
bestanden te openen – het is niet nodig het bestand eerst te ‘unzippen’).  Klik “Open”. 
Klik “OK”.   De caches in de Pocket Query (maximaal 500) worden nu in GSAK 
ingevoerd en er zal een overzicht van de ingevoerde gegevens worden getoond.   Klik OK 
om het overzicht te sluiten.

Cache-gegevens bekijken: Elke rij (regel) in GSAK toont nu één cache. Als je op een 
van de rijen klikt zullen de details van die cache in het Split Screen view worden 
getoond.

Wil je een cache op een kaart op een site in het internet getoond zien, zorg dan dat je een 
actieve internetverbinding hebt. Klik vervolgens met rechts op de rij waarin die 
betreffende cache wordt getoond en zet de cursor op “Custom URL” en selecteer de 
kaart die wilt zien (probeer eens “Google Satellite View”, onderaan de lijst van de 
Custom URL lijst).  

Sorteren:   Klik op een kolom-aanduiding om de caches te sorteren op de in die kolom 
getoonde gegevens.
Als voorbeeld:  Klikken op de kolom “Code” zal de caches sorteren op de GC-code 
(geocaching cache-code).   Als je een tweede keer op die kolom klikt draait de volgorde 
om. Klik op de Kms (of Miles) kolom-aanduiding zal de caches sorteren op afstand vanaf 
je huis. En weer: klik een tweede keer en de sortering wordt omgedraaid.

Caches selecteren: Om in GSAK een cache te selecteren klik onder het ikoon op de 
rij van de betreffende cache en er verschijnt een vinkje in de kolom. Dit is wat wordt 
genoemd de “User Flag” kolom.  Deze vinkjes (=User flags) kunnen worden gebruikt om 
de caches individueel of als groep te selecteren.  Om meerdere caches te selecteren klik je 
in de  User Flag-kolom bij elke cache die je wilt markeren en dus selecteren. 
Je kunt ook groepen caches selecteren via het User Flag menu of middels sneltoetsen op 
het toetsenbord (Klik op het User Flags menu om de keuzemogelijkheden te zien).   
Een handige mogelijkheid om grote groepen caches te markeren is User Flags>Select for 
next nn records.  Wat is “nn records”?  Dit zijn eenvoudigweg de volgende (nn) rijen 
(records) in het GSAK overzicht.  Als je deze mogelijkheid wilt gebruiken, klik dan op 
een cache in het overzicht en ga dan naar User Flags>Select for next nn records.   Type 
10 in het vakje dat verschijnt en klik op “OK”.  Je zult zien dat de 10 caches onder die 
waar je op geklikt hebt nu gemarkeerd zijn (de ‘userflag’ is ‘set’) en een vinkje is in de 
‘user flag’- kolom verschenen).

Om een markering te verwijderen (een cache deselecteren), klik je voor de tweede keer 
op de User Flags kolom van de cache en het vinkje verdwijnt.  Om alle caches te 
deselecteren ga naar User Flags>Clear all user flags.  Alle selecties zijn nu verdwenen!

Filteren: Een van de meest krachtige funkties van GSAK is het filteren van gegevens. 
Filteren stelt je in staat om een groep van caches te selecteren en dan met die caches als 



een set te werken.   Je kunt deleten, verplaatsen, kopiëren, exporterene of die groep naar 
de GPS-ontvanger versturen. Alles in één handeling.

Om te zien hoe filtering werkt, klik in de User Flag kolom om een paar caches te 
selecteren.  Druk dan op de F8 funktietoets van het toetsenbord. 
Je zult nu zien dat alleen nog maar de caches die je selecteerde in het overzicht worden 
getoond.  Je hebt nu de caches gefilterd waarvan de User Flag was aangezet en je kunt nu 
met die caches werken alsof het een afzonderlijke groep is.  Ga naar User Flags>Clear all 
user flags, of druk op funktietoets F7 van het toetsenbord om de markeringen uit te 
schakelen en weer alle caches te zien.

Filtering door GSAK user flags kan op veel andere manieren dan alleen met behulp van 
de user flags.  Om de caches op een andere manier te kunnen filteren ga je naar 
Search>Filter.  Of je kunt op de Filter button op de GSAK toolbar klikken. Die ziet er zo 
uit: 

Er wordt dan een dialoogvenster geopend , “Set Filter”, dat je alle filterkriteria toont met 
behulp waarvan je filtering kunt toepassen.  Er zijn meerdere ‘tabbladen’ in dit venster – 
elke tab geeft je weer nieuwe kriteria die je kunt gebruiken in de instelling van het filter 
om zo bepaalde caches uit te filteren.

We zullen een eenvoudig filter opzetten om te tonen hoe een en ander werkt. 
Stel je wilt alle Traditionele caches binnen een straal van 20 mijlen (of kilometers) van je 
huis zien.  Klik op Search>Filter.  Op de tab ‘General’, is het vierde item van boven 
“Distance”.   In het “Any Distance” rolmenu, selecteer je  “Less than or Equal To”. 
(Kleiner dan of gelijk aan: )  Type 20 in het vak rechts van het menu.

Klik nu op de  “Other” tab in het Set Filter dialoogvenster, en klik op “Clear All” onder 
de lijst met cache types.  Klik dan op het vak links van “Traditional”.   Klik op “Go” in 
de linker onderhoek van het Set Filter dialoogvenster.  GSAK keerr nu terug naar het 
overzicht en alles wat je nu nog ziet zijn de Traditional caches binnen een straal van 20 
mijlen (of Kms) rond je huis!

Om de filtering op te heffen  (en weer alle caches te zien), ga naar 
Search>Cancel Filter of Klik op de grote rode X button in de toolbar.

Waypoints naar de GPS-ontvanger sturen: GSAK kan een groep waypoints direct naar 
Garmin en Magellan GPS-ontvangers overbrengen.   Een groep is alles dat op dat 
moment zichtbaar is in het overzichtsscherm.  Dus, als je je caches met behulp van 
bepaalde kriteria hebt gefilterd zijn dat de caches die naar de GPS-ontvanger zullen 
worden gestuurd

Ga eerst naar GPS>Setup.    Selecteer het merk van je GPS-ontvanger (Garmin of 
Magellan).  Als de ontvanger met de computer verbonden wordt door middel van een 
USB-kabel (niet een USB-to-Serial converter), vink dan het “GPSr is USB” vakje aan. 
Wordt de ontvanger met behulp van een seriële kabel of een USB-naar-Seriëel-kabel met 



de computer verbonden, laat dan dit vakje blank en selecteer de COM poort (computer 
port) waarmee de ontvanger is verbonden. Bij  Magellans moet de Baud rate worden 
ingesteld bij Port Speed zoals die in de ontvanger is ingesteld.  (Alle Garmins gebruiken 
dezelfde snelheid dus die keuzemogelijkheid is niet beschikbaar bij Garmins).  Tenslotte 
moet nog het maximaal aantal waypoints die de ontvanger kan verwerken worden 
ingesteld  (Zie hiervoor de handleiding van de betreffende ontvanger)en klik “OK”. 

Door middel van filtering kun je nu de caches slecteren die je naar de GPS-ontvanger wilt 
versturen. Of je filtert helemaal niet en stuurt alle waypoints uit de database als de GPS-
ontvanger dat aan kan. Verzeker je er van dat het totaal aantal waypoints niet groter is 
dan de handleiding aangeeft als het maximale aantal

Verbind de GPS-ontvanger met de computer en schakel de ontvanger in.
Ga naar  GPS>Send Waypoints en klik op “Send”.  De geselecteerde waypoints zullen 
naar de ontvanger worden verstuurd.  

Heb je geen Garmin of Magellan GPS-ontvanger?   Of wil je waypoints versturen naar 
andere software (bijv. Navigatie-software op de computer)?  Zie Exporteren, hieronder.

Exporteren:   Filter de waypoints die je wilt exporteren (of je filtert niet en exporteert 
alle waypoints die in je database staan, als je dat wilt).

Ga naar File>Export en selecteer de manier waarop je wilt exporteren (aanpassen aan bijv 
de GPS-ontvanger of de software waarheen je wilt exporteren).   Er zal een 
dialoogvenster verschijnen dat is aangepast aan het type export dat je wilt doen. Er zijn te 
veel mogelijkheden beschikbaar om hier allemaal te bespreken. Zie het GSAK help-
bestand voor meer informatie (Help>Contents of F1 op de computer).  

Voor tips over hoe het GSAK help-bestand te gebruiken, kijk naar dit bericht in het 
GSAK forum: http://www.gsak.net/board/index.php?showtopic=955&st=0& - entry5743

Veel plezier bij het gebruik van GSAK!

Voor het vervolg hierop zie: “GSAK 201 – Customizing GSAK”,  dat je kunt ophalen bij: 
http://gsak.net/GSAK201_Dutch.doc

http://www.gsak.net/board/index.php?showtopic=955&st=0&#entry5743

